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Annotated Test Scenario 

The prototype test scenario for the Scene Graph Editor is designed to exercise all major functionality 

incorporated by the application prototype.  The test procedure emulates a typical use case for the Scene 

Graph Editor which includes loading, viewing, and manipulating an existing scene graph data file.  A 

scene graph data file containing a simple scene is provided for testing.  The scene consists of four 

geometry object nodes, each representing a cube, connected to the root node by transform nodes that 

independently position the cube geometry within the 3D landscape.  An annotated test procedure is 

presented below.  The annotations will be removed from the test procedure provided to the test subject.   

 

1. Start the Scene Graph Editor and load the scene graph data file named “myscene.osg”.   

 

Annotation:  The task is intended to test the user‟s ability to start the application and load a scene 

graph data file.  Completion of the task yields an active application with a view of the test scene, 

presented by the default viewport which is created at application start.  The actions expected to be 

taken by the test subject for successful task completion are:   

a. Use the File Explorer or the command line to start the application.  (The following steps 

can be skipped if the filename is specified at the command line or the file is dragged and 

dropped onto the application icon).   

b. Select the “Open…” command from the “File” menu to display the file open dialog (or 

use the Ctrl-O hot key).   

c. Locate and open the scene graph data file with the name “myscene.osg”.   

 

 

2. Create a second viewport with the mouse.  The viewport may be placed at any location with any size.   

 

Annotation:  The task is intended to assess the difficulty of creating a viewport with the mouse.  The 

procedure should be simple and straightforward but may not be obvious to the novice user.  
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Completion of the task creates a viewport of arbitrary size on top of the main viewport.  The actions 

expected to be taken by the test subject for successful task completion are:   

a. Press the „V‟ key to initiate the viewport creation procedure.   

b. Position the mouse cursor within the 3D canvas area.   

c. Press and hold the left mouse button.   

d. Drag the mouse to create a viewport of any size.   

e. Release the left mouse button.   

 

 

3. Use the viewport dialog to resize the main viewport such that it fills the bottom half of the window.  

This is the first of a series of tasks using the viewport dialog.   

 

Annotation:  The task is intended to evaluate the user‟s ability to interact with the viewport dialog.  

The user must be able to access the viewport dialog, select and resize the correct viewport, and 

properly apply the changes.  The viewport dialog provides an „Apply‟ button to apply changes 

without closing the dialog and an „Accept‟ button to both apply changes and close the dialog.  It is 

expected that an experienced user will use the „Apply‟ button to complete each of the viewport dialog 

related tasks, until the final task where the „Accept‟ button will be used. A novice user may use the 

„Accept‟ button more often, requiring the viewport dialog to be reopened for the proceeding step.  

Completion of the task reduces the height of the main viewport to one half of the current size and 

creates empty space within the 3D canvas area to which the second viewport will be moved.  The 

actions expected to be taken by the test subject for successful task completion are:   

a. Select the “Viewport Manager…” command from the “View” menu to display the 

viewport dialog (or use the Ctrl-V hot key).   

b. Select the “Main” entry from the viewport list with the mouse.   

c. Enter a value half as large as the current height value to the “Height” text entry field.   

d. Click the apply button with the mouse.   

 

 

4. Use the viewport dialog to move and resize the second viewport such that it fills the top half of the 

window.   

 

Annotation:  The task is an extension of the previous task which adds a test of the user‟s ability to 

move viewports with the viewport dialog.  It is expected that a user having difficulty with the previous 



task will have less difficulty with the current task.  Completion of the task moves the second viewport 

into the empty area at the top of the 3D canvas, making two viewports of equal size at the top and 

bottom of the canvas.  The actions expected to be taken by the test subject for successful test 

completion, assuming that the viewport dialog is left open after completion of the previous task, are:   

a. Select the “NewViewport” entry from the viewport list with the mouse.   

b. Enter the value of 0 to the “X” text entry field.   

c. Enter the value equal to the height of the main viewport to the “Y” text entry field.   

d. Enter the value equal to the width of the main viewport to the “Width” text entry field.   

e. Enter the value equal to the height of the main viewport to the “Height” text entry field.   

f. Click the apply button with the mouse.   

 

 

5. Use the viewport dialog to rename the main viewport to “Bottom View”.   

 

Annotation:  The task is intended to test the user‟s ability to rename a viewport with the viewport 

dialog.  Completion of the task changes the name of the main viewport from the default name 

assigned at application start.  The actions expected to be taken by the test subject for successful test 

completion, assuming that the viewport dialog is left open after completion of the previous task, are:   

a. Select the “Main” entry from the viewport list with the mouse.   

b. Enter the name “Bottom View” to the “Name” text entry field.   

c. Click the apply button with the mouse.   

 

 

6. Use the viewport dialog to rename the second viewport to “Second View”.  This is the last task in the 

series of tasks using the viewport dialog.   

 

Annotation:  The task is intended to test the user‟s ability to rename a viewport with the viewport 

dialog.  Although a novice user may use the „Accept‟ button to apply changes and close the viewport 

dialog at the completion of each of the previous tasks, it is expected that an experienced user will 

have used the „Apply‟ button to apply changes without closing the viewport dialog and will be using 

the „Accept‟ button for the first time when completing the task.  Completion of the task changes the 

name of the second viewport from the default name assigned at viewport creation.  The actions 

expected to be taken by the test subject for successful test completion, assuming that the viewport 

dialog is left open after completion of the previous task, are:   



a. Select the “NewViewport” entry from the viewport list with the mouse.   

b. Enter the name “Top View” to the “Name” text entry field.   

c. Click the accept button with the mouse to apply the change and close the dialog.   

 

 

7. Adjust the second viewport’s view by rotating the scene 180 degrees around the X axis.  The rotation 

does not have to be exact.   

 

Annotation:  The task is intended to test the user‟s ability to use the mouse to select a viewport and 

manipulate its view of the scene.  The user may either use the mouse to “drag” the view, or may 

“throw” the view.  It is expected that a novice user may require multiple passes at ”dragging” the 

view and an expert user will “throw” the view.  Completion of the task illustrates the “focus follows 

mouse” style of viewport focus selection by automatically transferring input focus to the second 

viewport upon mouse entry, allowing its view to be adjusted with the mouse.  The actions expected to 

be taken by the test subject for successful task completion are:   

a. Position the mouse cursor within the second viewport.   

b. Press and hold the left mouse button.   

c. Drag the mouse up or down until a 180 degree X axis rotation is achieved.    

d. Release the left mouse button.   

 

 

8. Reset the second viewport’s camera to the default position.   

 

Annotation:  The task is intended to test the user‟s ability to reset a specific viewport‟s view of a 

scene to the “home” position.  The second view must have focus when the reset command is issued if 

the task is to be completed successfully.  Completion of this task changes the view currently displayed 

by the main viewport to the default view displayed when the scene was loaded.  The actions expected 

to be taken by the test subject for successful task completion are:   

a. Position the mouse cursor within the main viewport.   

b. Press the „R‟ key.   

 

 

9. Use the viewport dialog to create a third viewport.  Do not move or resize the new viewport.   

 



Annotation:  The task is intended to test the user‟s ability to create viewports with the viewport 

dialog.  Completion of the task creates a new viewport at the default position (10, 10) with the default 

dimensions (100, 100).  The actions expected to be taken by the test subject for successful task 

completion are:   

a. Select the “Viewport Manager…” command from the “View” menu to display the 

viewport dialog (or use the Shift-V hot key).   

b. Click the add button with the mouse.   

c. Click the accept button with the mouse to apply the change and close the dialog.   

 

 

10. Change the background color for the second viewport to red and the third viewport to green.   

 

Annotation:  The task is intended to test the user‟s ability to change a specific viewport‟s background 

color.   The target view must have focus when the color change command is issued if the task is to be 

completed successfully.  Completion of the task provides each viewport with a distinct background 

color.  The actions expected to be taken by the test subject for successful task completion are:   

a. Position the mouse cursor within the second viewport.   

b. Press the „B‟ key to display the color selection dialog.   

c. Select the green color from the color selection dialog‟s color list and click the accept 

button with the mouse.   

d. Position the mouse cursor within the third viewport.   

e. Press the „B‟ key to display the color selection dialog.   

f. Select the red color from the color selection dialog‟s color list and click the accept button 

with the mouse.   

 

 

11. Change the ambient light color for the third viewport to red.   

 

Annotation:  The task is intended to test the user‟s ability to change a specific viewport‟s ambient 

light color.  The target view must have focus when the color change command is issued if the task is 

to be completed successfully.  Completion of the task changes the ambient light value for the third 

viewport from the default white color to red, giving all objects present in the scene a red tint.  The 

actions expected to be taken by the test subject for successful task completion are:   

a. Position the mouse cursor within the third viewport.   



b. Press the „A‟ key to display the ambient light color selection dialog.   

c. Select the red color from the color selection dialog‟s color list and click the accept button 

with the mouse.   

 

 

12. Use the viewport dialog to remove the third viewport.  

 

Annotation:  The task is intended to test the user‟s ability to remove viewports with the viewport 

dialog.  Completion of the task removes the newest viewport from the 3D canvas area.  The actions 

expected to be taken by the test subject for successful task completion are:   

a. Select the “Viewport Manager…” command from the “View” menu to display the 

viewport dialog (or use the Shift-V hot key).   

b. Select the “NewViewport” entry from the viewport list with the mouse.   

c. Click the remove button.   

d. Click the accept button.   

 

 

13. Change the first transform node’s parent from the root node to the second transform node.   

 

Annotation:  The task is intended to test the user‟s ability to reorganize the scene hierarchy with the 

drag and drop functionality.  Completion of the task changes the transform node‟s parent to another 

transform node, altering the position of the transform node and its child geometry within the 3D 

landscape.   The actions expected to be taken by the test subject for successful task completion are:   

a. Expand the root node found within the tree list, if necessary.   

b. Position the mouse cursor over the first child of the root node.   

c. Press and hold the left mouse button.   

d. Drag the mouse cursor over the second child of the root node.   

e. Release the left mouse button.   

 

 

14. Rename the transform node that was moved by the previous task to “transform child 1”.   

 

Annotation:  The task is intended to test the user‟s ability to alter the name property of a specific 

node with the property sheet.  The user must first select the target node from the tree list and then edit 



the value presented by the property sheet.  Completion of the task changes the name of the transform 

node for both the tree list display and the scene‟s internal data structure.  The actions expected to be 

taken by the test subject for successful task completion are:   

a. Select the transform node, which was relocated by the previous task, from the tree list 

with the mouse.   

b. Enter the name “transform child 1” to the “Name” text entry field found within the 

property sheet located below the tree list.   

c. Press the “Enter” key to apply the name change.   

 

 

15. Locate the geometry object that is the child of the transform node which was moved by the previous 

task and change the value of its first vertex to 50.   

 

Annotation:  The task is intended to test the user‟s ability to edit a specific geometry node‟s vertex 

data with the property sheet.  The user must first select the target node from the tree list and then edit 

the correct value presented by the property sheet‟s vertex table.  Completion of the task alters the 

shape of a cube such that it is no longer a cube.  The actions expected to be taken by the test subject 

for successful task completion are:   

a. Select the geometry node found at the leaf position of the branch extending from the 

transform node that was relocated by the previous task from the tree list with the mouse.   

b. Enter the value 50 to the cell found at the first row of the “X” column from the vertex 

table found within the property sheet located below the tree list.   

c. Press the “Enter” key to apply the value change.   

 

 

16. Save the current scene graph to a scene graph data file named “myscene2.osg”.   

 

Annotation:  The task is intended to test the user‟s ability to save a scene to a file.  Completion of the 

task creates a new scene graph data file named “myscene2.osg” containing the altered scene data.  

The actions expected to be taken by the test subject for successful task completion are:   

a. Select the “Save As…” command from the “File” menu to display the file save dialog (or 

use the Ctrl-Shift-S hot key).   

b. Enter the new file name “myscene2.osg” and press the accept button to save the file.   


